
Quick Reference Guide

THE PRO-STITCHER WORKSPACE

This guide will help you through the learning curve of 
the user interface, finding commonly used features, and 

becoming familiar with new features you’ll love using.
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Pro-Stitcher™ PREMIUM

Quick-Access 
Toolbar: Buttons 
shown here are 
always visible. 
You can assign 
your favorite 
commands to 
this toolbar.

Help buttons: Select the Help tab for on-screen indexed and 
hyperlinked help content. Select the Help button and then click a 
button or tab on the screen for context-sensitive help.

Ribbon: The buttons on the Ribbon change 
according to which tab is selected.

Sidebar: The 
sidebar includes 
buttons for the 
functions tied to 
the various Ribbon 
buttons. The 
Sidebar Tabs relate 
to other aspects of 
the workspace.

Tabs: Select any tab to display its buttons and functions.

Select All

Multi Select
Zoom to 
Design

Zoom to 
Area

Zoom to 
Actual Size

Zoom the work-
space: Touch the 
plus (+) or minus 
(--) buttons to 
zoom in or out,  
or use the slider 
bar: slide right to 
zoom in or left to 
zoom out.

Workspace Toolbar: Buttons shown 
here are always visible. Only one 
button can be selected at a time.

Select None

Refresh

Rulers

Design rubber 
band (green)

Design start 
point (green)

Jump (purple dotted line): not stitched

Design end 
point (red)

Design bounding 
box (blue)

Pan Scroll 
Bars

Open or hide sidebar



LEARNING PRO-STITCHER PREMIUM

WHERE’S THE USER MANUAL?

Your Pro-Stitcher came with a Getting Started Guide that includes installation instructions, safety information, troubleshooting tips. 
The software operation and reference information is available as an on-screen, context-sensitive help system and has an indexed 
and hyperlinked reference guide. Both are accessible from within Pro-Stitcher. This enables you to look up instructions related to a 
specific function while you are using the software.

ACCESSING ON-SCREEN HELP IN PRO-STITCHER

Context-sensitive onscreen help: The context sensitive help enables you to select a button or function within Pro-Stitcher and display 
a pop-up help window describing just that feature. The information is usually more concise than using the Reference Guide. If after 
reading the context-sensitive help you want more information, refer to the Reference Guide.

Reference Guide: The reference guide is structured much like other help systems in Microsoft Windows-based software. It has a 
table of contents, an index, search capability, and hyperlinks between help topics.

To Do This Select This Then Do This

Display context-sensitive 
onscreen help

Select a Pro-Stitcher tab, button, or area on the workspace to display a text box with 
information about that function.

Access the reference guide Select the reference guide help tab, then select the Help button in the Ribbon.

LEARNING PRO-STITCHER PREMIUM

General instructions: To access the various Pro-Stitcher Premium functions, you will typically select one of the tabs which displays a 
ribbon of buttons below the tabs. When you select a ribbon button, customization options for that function display in a sidebar 
along the right side of the screen. (If the Sidebar is closed, choose the Open Sidebar arrow button at the upper-right corner by the 
Pro-Stitcher workspace.)

To Do This Select This Then Do This

Open, close, or save one or 
more design(s).

File tab Choose Design >  Open, Close > Selected, or Save > Selected from the Ribbon.

Shut down Pro-Stitcher File tab Choose the File tab, and then choose Shutdown from the Ribbon. From the menu 
choose Shut down to shut down the Pro-Stitcher software and the tablet; choose 
Reboot to restart the tablet and the software; or Exit to Windows to shut down the 
software but return to the Windows desktop. 

Show or hide the design, the 
bounding box, the area box, 
the rubber band, the jump 
points, start and stop points, 
the grid lines, the scroll bars, 
design points, or the rulers

View tab Choose the items from the Ribbon that you want to display or not.

Duplicate or clear a design Edit tab Choose Duplicate or Clear All from the Ribbon.

Create an area Area tab Choose 2-Corner or Multi-Point from the Ribbon; then fine tune on the Sidebar.

Baseline the design 
modifications

Modify tab Choose Baseline from the Ribbon; you can also assign the Baseline button to the 
Quick Access Toolbar.

Rotate, flip, or mirror a 
single or grouped design

Modify tab Choose Rotate; choose either Group or Single on the sidebar; then choose from the 
rotate options.

Crop the design relative to 
an area

Modify tab Create the area. Choose Crop from the Ribbon, choose Outside or Inside on the 
Sidebar. Then indicate whether to perform a tieoff at the jump points (disable the 
Edges button) or to stitch between jump points (select the Edges button).



Crop the design based on 
the design’s start and end 
points

Modify tab Move the design’s start and/or end points (Pro-Stitcher > New Start/End). Then 
choose Crop from the Ribbon and Start-End on the sidebar. Then indicate whether to 
perform a tieoff at the jump points (disable the Edges button) or to stitch between 
jump points (select the Edges button).

Change the dimensions of 
the design

Modify tab Choose Resize from the Ribbon. Choose Lock to lock the aspect ratio if desired. 
Choose either Width, Height, Original Width, or Original Height on the sidebar; 
then use the Plus (+) and Minus (—) to adjust the dimension.

Skew the design Modify tab Create an area and open a design. Select Modify > Skew to open the Skew sidebar. 
Generally you will use Skew 1 when skewing to a convex area and Skew 2 when 
skewing to a concave area.

Swap the quilting start and 
end points

Modify tab Select the Swap button.

Repeat designs in the 
workspace

Repeat tab Add or remove design repeats using the Plus (+) and Minus (—) buttons, or select 
the Fill button to have Pro-Stitcher automatically calculate the optimal number of 
repeats both horizontally and vertically. Add more horizontal or vertical repeats if 
desired, and then stretch them vertically and horizontally to fit them to the area.  

Wrap repeated designs in 
the workspace

Repeat tab Offset rows of repeated designs, or shift the entire design window. 

Stitch perfectly straight lines 
across the quilt

Pro-Stitcher 
tab

Use Channel Lock to stitch horizontally or vertically, or use Move with the Stitch 
button selected to stitch up, down, left, right, or diagonally.

Quilt a design Pro-Stitcher 
tab

Select Quilt from the Ribbon. (Make sure the Stitch button is selected in the 
Sidebar.) Then select Run. 

Recover from a thread break 
or running out of bobbin 
thread

Pro-Stitcher 
tab

Use New Start & End to change the start point of the design to the position where 
Pro-Stitcher needs to resume stitching.

To Do This Select This Then Do This

SIDEBAR RIBBON BUTTON REFERENCE

FILE TAB RIBBON BUTTONS

Design: Opens a design file. Navigate through your 
computer’s file system to locate the design file you 
want to use. The drop-down menu also shows the 
design files you most recently used for quick access. 

Workspace: Opens a workspace file. Navigate through 
your computer’s file system to locate the workspace 
file you want to use. The drop-down menu also shows 
the workspace files you most recently used for 
quick access. 

Area: Open an area file. Navigate through your 
computer’s file system to locate the area file you want 
to use. The drop-down menu also shows the area files 
you most recently used for quick access. You can have 
only one area open at a time. 

Save: Select to save the selected design(s), the 
workspace, or the area. 

Close: Select to close the selected design(s), the 
workspace, or the area. You will be prompted to 
save any objects that have had changes.

Clear All: Select to close everything in the workspace. 
Be sure to save anything you want to keep 
before clearing.

Update: After downloading the update to a USB drive, 
insert the drive into the Pro-Stitcher bracket’s 
USB ports and select this button to update the 
Pro-Stitcher software.

 

Shut Down: Select to exit Pro-Stitcher. From the 
menu, select Shut Down to quit the software and 
shut down the tablet computer; select Reboot to 
restart both the tablet computer and software; or 
select Exit to Windows to exit the software but  
leave the tablet computer on.



History: Use to show a list of your most recent actions 
with Pro-Stitcher. Select an item on the History list 
to return the design to the state it was when that 
function was performed. Or select Clear History to 
clear the entire design history. 

Undo: Use the Undo button to undo the last function 
performed. Continue selecting Undo as needed to get 
the design back to where you want it. 

‘Redo: If you change your mind about the last Undo 
action, select the Redo button.

Cut: Cuts the selected design(s).

AREA TAB RIBBON BUTTONS

MODIFY TAB RIBBON BUTTONS

Copy: Copies the selected design(s).

Paste: Pastes the copied design(s), positioning the 
design start point at the needle position (indicated by 
the cross hairs).

Duplicate: Select the design(s) you want to duplicate 
and then choose the Duplicate button. If one design 
is selected, only that design is duplicated. If multiple 
designs are selected, all selected designs are 
duplicated. 

Clear All: Select to close everything in the workspace. 
Be sure to save anything you want to keep before 
clearing.

File: Use to open an area file you have saved. Navigate 
through your computer’s file system to locate the 
area file you want to use. The drop-down menu 
also shows the area files you most recently used for 
quick access. 

Select: Selects the area in the workspace. The area 
turns from a purple line to a green line to indicate 
it is selected. You can then use your finger to drag 
and drop it, or select the XForm (Transform) button 
and use the transform handles to resize, rotate, or 
reposition the area.

Clear: Select to clear the current area.

EDIT TAB RIBBON BUTTONS

2 Corner: Use to create a 2-corner (rectangular) area. 
Position the needle where you want the area to begin 
and select 2 Corner, usually the upper-left corner of 
the area. Then move the cross hairs to the opposite 
corner of the area and press 2 Corner again. Fine tune 
the dimensions of the area in the Area sidebar.

Multi-Point: Use to create a multi-point (concave or 
convex) area. Position the needle where you want 
the area to begin and select Multi-Point. Move the 
needle to the next point along the perimeter of the 
area and select Multi-Point again. Continue in this 
manner until you have created an area. 

Baseline: Use the Baseline button to "freeze" the 
modifications you have made to the design.  Once you 
baseline, all modifications treat the design as a new 
unaltered design. However, baseline does not save 
the design to your computer.

Rotate: Select the Rotate button to open the Rotate 
Sidebar. You can rotate a single design or multiple 
designs.

Reposition: Use the Reposition options to position a 
design relative to the needle position (represented by 
the cross hairs on the screen).

Resize: Select the Resize button to open the Resize 
Sidebar. You can adjust the height and width, as well 
as the original height and original width (if the design 
has been rotated). You may also lock the aspect 
ratio so the height and width increase or decrease 
proportionately.

Crop: Use the Crop function in conjunction with a 
defined area. After a design has been loaded and 
modified as needed, mark an area that represents the 
region to be cropped. Select the Crop button to open 
the Crop Sidebar. If the Crop options are not available, 
an area has not yet been defined.

Align: After you create an area, use the align options 
to position the design within the area. To open the 
Alignment Sidebar, select the Align button. Then 
select from the alignment button(s) to position the 
design within the area.

Skew: After you create an area, use the skew 
options to fit the design within the area. Any further 
formatting you do to the design will also stretch to the 
limits of the area. The Skew options aren't available 
until you define an area and open a design.

Swap: Use this button for those times when you want 
to switch the quilting start and end points, such as 
when you rotate or flip a design and the start point is 
now at the right side of the design. 

Basic: Provides several options for repeating designs 
both vertically and horizontally. If you have created an 
area, you can also have Pro-Stitcher determine how 
many repeats will fit within the area.

REPEAT TAB RIBBON BUTTONS
Wrap: Provides several options for wrapping, or 
offsetting, designs either vertically or horizontally. 
Most of these options can be done with or without a 
defined area. 



VIEW TAB RIBBON BUTTONS

PRO-STITCHER TAB RIBBON BUTTONS

Half Stitch: Select to cycle the needle either to the up 
or the down position based on the current position of 
the needle.

Full Stitch: Select to cycle the needle a full stitch to 
the up position. If the needle is in the down position, 
it will move only a half cycle so it stops in the up 
position. Subsequent presses of the button, however, 
will cycle a full stitch, always ending with the needle 
in the up position. 

Follow: Select Follow when you want to ensure that 
the cross hairs remain in view when you have zoomed 
into a design. This saves you from having to use Pan to 
find the cross hairs. It is also helpful to enable Follow 
when you stitch a wide design because you can both 
zoom in on the design and always see what is being 
stitched on the screen.

Measure: Select to measure distances in a design or 
directly on the quilt. 

Baste: Press the Baste button to quickly access 
basting stitch mode. Begin basting the quilt by 
pressing the Start button on the handlebars.

Quilt: Select when you are ready to begin quilting; 
then select Run. If Verify Before Quilt is enabled 
(Settings Tab > Advanced > General), Pro-Stitcher 
displays all of the settings for you to review. Press 
Proceed to continue.

Channel Lock: Select this button have Pro-Stitcher 
stitch horizontal or vertical lines that are perfectly 
square with the frame. On the Channel Lock Sidebar, 
choose either the Horizontal or Vertical button and 
begin stitching.

Rulers: Select to hide or show the workspace top 
and side rulers. This button may be added to the 
Quick-Access toolbar to quickly turn the rulers 
on or off.

Grid: Select to hide or show the workspace grid. This 
button may be added to the Quick-Access toolbar to 
quickly turn the workspace grid on or off.

Scroll: Select to hide or show the bottom and right-
side scroll bars in the workspace. Use the scroll bars 
to pan up and down or left and right. This button may 
be added to the Quick-Access toolbar to quickly turn 
the scroll bars on or off.

Transparency: Select to hide or show the workspace 
lightly below Pro-Stitcher screen areas beyond the 
main workspace, such as below the ribbon buttons, 
the sidebar, the status bar, and the toolbars.

Area: Select to hide or show the area box. This button 
may be added to the Quick-Access toolbar to quickly 
switch between showing the area box or removing it 
from view.

Move: The Move option enables you to move the 
quilting machine in any of the 8 directions indicated 
by the direction arrows by pressing that arrow button. 
Select the Continuous button for the machine to 
move continuously, select the Stitch button to stitch 
as you press the arrow button, or select both the 
Continuous and Stitch buttons to stitch continuously. 
Press the Stop button that appears to turn off the 
Continuous operation.

New Start & End: Use this button to start quilting a 
design from some point other than the design's start 
point. You may need to do this because the thread 
breaks, the bobbin runs out, or you simply want to 
stitch a specific portion of a design. Similarly, you may 
change the ending point to a point other than the 
design’s original end point.

Record: Pro-Stitcher can record the movement of 
the quilting machine. For example, record your own 
background designs across the width of the quilt. Or 
record your signature so you can quilt your signature 
into your quilts.

Gears: Typically you will engage the Pro-Stitcher 
motors when using computerized quilting and 
disengage them for free-motion quilting. Choose the 
Gears button to automatically engage or disengage 
the motors if you have an EZ Carriage. If you have 
a carriage with levers, manually raise the levers to 
disengage or lower them to engage the motors. If you 
are going to have Pro-Stitcher record your stitching 
(Pro-Stitcher Tab > Record), disengage the motors for 
a smoother free-motion quilting experience. 

Clear Trace: As Pro-Stitcher stitches, the portion of 
the design that has been stitched turns to orange on 
the screen. At any time you can clear that "tracing" 
by choosing the Clear Trace button. If you are in 
the process of stitching out the design, first select 
the Pause button and then Clear Trace. Then press 
Resume to continue stitching.

Design: Select to hide or show the design from the 
workspace. This button may be added to the Quick-
Access toolbar.

Bounds: Select to hide or show the bounding box 
around the selected design(s). This button may be 
added to the Quick-Access toolbar.

Rubber Band: Select to hide or show the rubber band 
around the selected design(s). The rubber band shows 
the smallest area required by the entire design.

Jumps: Select to hide or show the stitching path 
between jump points, or places where you need to 
stop stitching, tie off your thread, and then continue 
stitching at the next start point. This button may be 
added to the Quick-Access toolbar.

Start End: Select to hide or show the quilting start 
and end points in a design. This button may be added 
to the Quick-Access toolbar.

Design Point: Select to hide or show design points.
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KING QUILTER II COMPUTERIZED QUILTING SYSTEM

PRO-STITCHER PREMIUM
USER MANUAL

Help: Select to open the on-screen Pro-Stitcher 
reference guide. It has a table of contents, an index, 
search capability, and hyperlinks between help topics.

SETTINGS TAB RIBBON BUTTONS

HELP TAB RIBBON BUTTONS

Display: Select to turn on or off Touch Mode, 
customize the Quick-Access Toolbar, and 
configure Pro-Stitcher so it works best with 
your tablet computer.

  

Defaults: Select to set the Nudge increment and 
Auto Jump threshold defaults.

Opti-Stitch™: Automatically calculates speed and 
acceleration to match the quilter’s chosen design and 
responds with optimal stitch performance. Manual 
control of speed and acceleration are available.   
To customize speed and acceleration:  
  1. Select the Setting tab, then select the 
      Opti-Stitch button.  
  2. Select the Customize button to manually adjust 
      speed and acceleration using the slider, or type 
      in a value.  
  3. Turn off the Customize button to return to default 
       settings.

Auto Jump: Select to temporarily override the Auto 
Jump default. Touch the Plus Sign (+) to increase 
or Minus Sign (–) to decrease the stitches per inch. 
Alternately, touch the number box and type a value 
directly and press Enter.

About: Select to open the About box. This is where 
you will find the Pro-Stitcher version number, as well 
as the key code you’ll need if you decide to purchase 
any digital designs that are encrypted.

TOOLS TAB RIBBON BUTTONS

Stitches per Inch: Select to set the stitches per inch. 
Touch the Plus Sign (+) to increase or Minus Sign (–) 
to decrease the number of stitches per inch. 
Alternately, touch the number box and type a 
value directly and press Enter.

Tieoffs: Select to specify your preferred method for 
how and when Pro-Stitcher performs tieoffs. 

Pullup: Select to specify your preferred method for 
how Pro-Stitcher performs pullups.

Pause Delay: Select to specify your preferences for 
how Pro-Stitcher pauses for you to trim threads after 
starting to stich the design. Specify either the number 
of seconds it will pause for you to cut your threads or 
how many inches it will stitch before pausing for you 
to cut the threads.

Advanced: Settings that are not likely to be used often 
can be found by selecting the Advanced button. Some 
of these settings include communications between 
the quilting machine and the Pro-Stitcher,  
Simulation mode, and other options.

Art & Stitch: Select to pass the selected design(s) to 
Art & Stitch, select the Tools tab and then select the 
Art & Stitch button. If Art & Stitch is open and has 
been licensed, the design will open in Art & Stitch. 
If Art & Stitch has not yet been licensed, a licensing 
screen will appear for entering license information.


